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1. イントロダクション 

GIGAPORT eX をお買い上げいただき誠にありがとうございます。GIGAPORT eX はマルチチャン
ネル再⽣に特化することで、市場で最も優れたコストパフォーマンスを実現した製品です。 

独⽴ 8 系統出⼒（7.1 サラウンド対応）、独⽴ 2 系統ステレオヘッドホン出⼒、最⼤ 24bit 192 kHz
の⾼⾳質サウンドを特徴とする GIGAPORT eX は、プロフェッショナルなオーディオ･ミキシング／
プレイバックの要求にも応える ASIO 2.0 ドライバー（Windows 7/8.1/10）で駆動します。
CoreAudio にもネイティブ対応し、OS X / macOS ではドライバーのインストールが不要です。
GIGAPORT eX は、ノート PC を⽤いたデジタル DJ に最適なソリューションを提供します。好みの
DJ ソフトウェアで各出⼒を 4 つのステレオチャンネルに振り分けることで、ミックス、キュー、エ
フェクトの信号を GIGAPORT eX から個別に出⼒できます︕2 系統の内蔵ヘッドホン出⼒で個別の
信号をモニターできます。もちろんデスクトップ PC でも動作し、主要なすべてのプロ⽤ DAW ソフ
トウェアで使⽤することができます。DVD 再⽣ソフトウェアなど、コンシューマー⽤アプリケー
ションでも使⽤可能です。 

GIGAPORT eX は、USB 3.1 で動作する USB-C デバイスです。標準的な USB 2.0 接続にも対応し
ます。 

1.1 機能 

GIGAPORT eX の主なハードウェア構成︓ 

 

- USB-C コネクター︓コンピューターやモバイル機器に接続する端⼦です。製品に付属する 2
本の USB-C 接続ケーブルのいずれかを使⽤して、Mac、PC、モバイル機器と接続します。機
器動作中は、USB-C 端⼦右側の電源 LED（“POWER”）が点灯します。 

- ステータス LED x 8︓再⽣チャンネルの動作状況を表⽰します。各出⼒チャンネルからオー
ディオ･データが送出されているかを LED の点灯で確認できます。 

- ヘッドホン出⼒（“1/2”）︓アンバランス 1/4 インチステレオ TRS コネクター（チャンネル
1/2）。ライン出⼒ 1 および 2 への信号をモニターできるヘッドホン端⼦です。この出⼒は、
チャンネル 3〜8 の信号と独⽴して動作します。外部ミキサーを⽤いずに DJ アプリケー
ションを使⽤する場合などに⾮常に便利な機能です。 
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- ヘッドホン出⼒（“MIX”）︓アンバランス 1/4 インチステレオ TRS コネクター（ミック
ス）。8 つ（またはステレオ x 4）のすべての出⼒チャンネルのミックス信号が出⼒される
ヘッドホン端⼦です。すべての物理出⼒チャンネルからの信号をモニターできます。 

リアパネルのコネクター︓ 

 

- ライン出⼒1〜8︓アンバランスRCA端⼦。メイン信号が出⼒される端⼦です。各出⼒チャン
ネルには、番号が割り振られています。 
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2. インストール 

2.1 推奨システム 

GIGAPORT eX は単なるデジタルオーディオ･インターフェイスではなく、オーディオコンテンツを
⾼度に処理するハイレゾオーディオデバイスです。CPU 負荷は⾼くありませんが、接続するシステ
ムの性能が GIGAPORT eX のパフォーマンスに⼤きく影響します。そのため最新のパーツで構成さ
れたコンピューターの使⽤を推奨します。 

最⼩システム要件 

PC 

- Windows 7 / 8 / 8.1 / 10（32 および 64-bit） 

- 1 系統の USB 2.0 または USB 3.1ポート（タイプ A またはタイプ C） 

Mac 

- OS X / macOS 10.9以上 

- 1 系統の USB 2.0 または USB 3.1ポート（タイプ A またはタイプ C） 

2.2 ハードウェアの接続 

GIGAPORT eX は、コンピューターの USBポートと直接接続して使⽤します。いわゆる“タイプ A”
または“タイプ C”の USB ポートでコンピューターと接続します。製品には、両タイプのケーブルが
同梱されています。いずれかのケーブルを使⽤し、GIGAPORT eX とコンピューターを接続してく
ださい。 

  
コンピューターの USB “タイプ A” ポート コンピューターの USB “タイプ C” ポート 
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2.3 ドライバー＆ソフトウェアのインストール 

GIGAPORT eX をコンピューターに接続すると、新規ハードウェアデバイスとして機器が⾃動的に
認識されます。ただし、GIGAPORT eX のすべての機能を使⽤するにはドライバーのインストール
が必要となります。 

GIGAPORT eX をコンピューターに接続する前に、www.esi-audio.com から最新のドライバーを
ダウンロードすることを強く推奨します。ドライバーをインストールすることで、GIGAPORT eX
のすべての機能が Windows / OS X / macOS で利⽤できるようになります。 

お使いのブラウザーで以下のページにアクセスすることで、PC または Mac ⽤の最新ドライバー／
ソフトウェアを⼊⼿できます。 

>>>    http://en.esi.ms/110    <<< 

2.3.1 Windowsへのインストール 

この章では、GIGAPORT eX ⽤ドライバーを Windows 10 にインストールする⽅法を解説します。
Windows Vista、7、8、8.1 をお使いの場合も、基本的な⼿順は同様です。ドライバーをインス
トールする前に GIGAPORT eX をコンピューターに接続しないでください。すでに接続済みの場合
は、ケーブルを取り外してからインストール作業を⾏ってください。 

インストールを開始するには、ウェブサイトから最新ドライバーをダウンロードし、解凍したファ
イルから“setup.exe”を起動します。インストーラーを起動する際、Windows によってセキュリ
ティのメッセージが表⽰される場合があります。その場合は、インストールの許可を与えてくださ
い。次に、左下に⽰すダイアログが表⽰されます。“Next” をクリックすると、右下に⽰すダイアロ
グが表⽰されます。 

   

“Install” をクリックします。ファイルのコピーが開始されます。しばらくすると以下のダイアログ
が表⽰されます。 



ESI GIGAPORT eX 

7 

 

“Next” をクリックします。引き続きファイルがコピーされ、以下の Windows セキュリティメッ
セージが表⽰されます。 

 

“Install” をクリックします。しばらくするとインストールが完了し、以下のダイアログが表⽰され
ます。 

   

左上図のウインドウが表⽰されたら、“Finish” をクリックします。多くの場合、右のダイアログが
表⽰されます。“Yes, restart the computer now”を選択した後 “Finish” をクリックして、コン
ピューターを再起動することを強くお勧めします。 
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これで GIGAPORT eX をコンピューターに接続できます。Windows が⾃動的に機器を検出し、
GIGAPORT eX が使⽤可能となります。 

システム再起動後、インストールの完了を確認するため、以下に⽰すオレンジ⾊の ESI アイコンが
タスクバーの通知エリアに表⽰されているかをご確認ください。 

 

このアイコンが表⽰されていれば、ドライバーのインストールが適切に完了したことになります。 

 

2.3.2 OS X / macOSへのインストール 

OS X / macOS で GIGAPORT eX を使⽤するには、コントロールパネルソフトウェアをウェブサイ
トからダウンロードする必要があります。ご使⽤の OS X / macOS のバージョンに関わらず、コン
トロールパネルをダウンロードしてください。 

ダウンロードした dmg ファイルをダブルクリックすると、以下のウインドウが Finder に表⽰され
ます。 

 

GIGAPORT eX コントロールパネルをインストールするには、“アプリケーション” フォルダーにク
リック＆ドラッグします。インストールはこれで完了です。 

GIGAPORT eX の主要な機能は GIGAPORT eX コントロールパネルで設定しますが、⼀部のオプ
ションは、Audio MIDI 設定（“アプリケーション”/“ユーティリティ”）で変更する必要がありま
す。 
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3. Windows コントロールパネル 

本章では、Windows 版 GIGAPORT eX のコントロールパネルについて解説します。タスクバーの
通知エリアに表⽰される ESI アイコンをダブルクリックすると、コントロールパネルが表⽰されま
す。コントロールパネルの画⾯は以下の通りです。 

 

“File” メニューの“Always on Top” オプションを有効にすると、他のソフトウェア使⽤中もコント
ロールパネルウインドウが常に前⾯に表⽰され、“Windows Audio Settings” をこの画⾯から起動
できます。“Config”メニューの“Factory Defalts” を選択すると、コントロールパネルとドライバー
のパラメーターがデフォルト値にリセットされます。また、“Help” > “About” にて、現在のバー
ジョン情報を確認できます。ウインドウのメニュー下部には、主な機能や設定項⽬が表⽰されてい
ます。 

1 / 2、3 / 4、5 / 6、7 / 8 

全再⽣チャンネルのボリュームコントロールスライダーと信号レベルメーターがステレオペアーで
表⽰されます。各スライダーの下側には、ミュートボタン（“M”）を備えます。LR チャンネルを同
時にステレオ仕様でコントロールするには、スライダー下部の“LINK” スイッチをオンにする必要が
あります。無効の場合、各チャンネルは個別に変更されます。 

MASTER 

すべての再⽣チャンネルをミックスした信号のボリュームコントロールスライダーとレベルメー
ターが表⽰されます。各スライダー下部には、ミュートボタン（“M”）を備えます。LR チャンネル
をステレオ仕様で同時にコントロールするには、スライダー下部の“LINK” スイッチをオンにしま
す。オフにすると、各チャンネルを個別にコントロールできます。 



ESI GIGAPORT eX 

10 

Sample rate 

ウインドウ最下部には、現在のサンプルレートが表⽰されます。サンプルレートの値は、メニュー 
“Config” > “Samplerate” から変更できます（再⽣中は変更不可）。GIGAPORT eX はデジタル
オーディオインターフェイスです。すべてのアプリケーションおよびオーディオデータは、同じ
サンプルレートで⼀様に処理されます。ハードウェアは、44.1 kHz〜192 kHz にネイティブ対応し
ています。 

3.1 レイテンシーおよびバッファー設定 

コントロールパネルのメニューから“Config” > “Latency” を選択すると、GIGAPORT eX ドライ
バーのレイテンシー（“バッファーサイズ”とも呼ばれます）を変更するダイアログが表⽰されま
す。バッファーサイズの値を⼩さくすると、レイテンシーの値が⼩さくなります。ソフトウェア
シンセサイザーの演奏時など、使⽤する場⾯によってはレイテンシーが少ない（バッファーが⼩さ
い）と有利な場合があります。また、最適なレイテンシー設定は、お使いのシステムの性能に直接
依存します。システムの負荷が⾼い場合（使⽤するチャンネル数やプラグインが多い、など）は、
レイテンシーを⼤きくした⽅が良いでしょう。レイテンシーバッファーサイズは、サンプル値で設
定します。ミリ秒単位で知りたい場合は、オーディオアプリケーションのレイテンシー設定画⾯を
確認すると良いでしょう。多くのアプリケーションは、ミリ秒単位でレイテンシーを表⽰するから
です。また、レイテンシー設定の変更は、オーディオアプリケーション起動前に⾏う必要がありま
す。 

メニュー“Config” > “USB Buffer”にて、ドライバーが使⽤する USB データ伝送バッファーサイズ
を設定できます。通常はこの値を変更する必要はありません。ただしこの値はオーディオレイテン
シーと安定性に若⼲影響を与えるため、ユーザーが調整できるようにしています。リアルタイム処
理でのレイテンシー値や、CPU ⾼負荷時の動作の向上が求められる場合は、この設定を変更するこ
とでパフォーマンスを最適化することができます。USB バッファーの最適な値は、同時に使⽤する
他の USB 機器や、インストールされている USB コントローラーの種類など、様々な要因で変化し
ます。 

3.2 DirectWIRE出⼒チャンネル 

Windows の場合、GIGAPORT eX は DirectWIRE 出⼒チャンネルという機能によって、アプリケー
ションのオーディオチャンネルと物理オーディオ出⼒との接続を切り替えることができます。変更
は、再⽣中であっても即座に反映されます。 

注意︓DirectWIRE は、特別な場⾯やプロフェッショナル⽤途を想定して作られた⾮常にパワフル
な機能です。ほとんどの場合、DirectWIRE の設定は不要です。特定の⽤途以外に設定を変更する
必要はありません。 
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設定ダイアログを開くには、コントロールパネルのメニューから“DirectWIRE” > “Output 
Channels”を選択します。以下のウインドウが表⽰されます。 

 

ウインドウには、8 系統の出⼒チャンネルがリスト表⽰されます。左の列は、GIGAPORT eX の物
理出⼒を⽰します。右の列は、コンピューターの再⽣チャンネルを⽰します。たとえば、この列の
値 1 および 2 は、チャンネル 1/2 の信号が再⽣されることを意味します。デフォルトでは、再⽣
チャンネル 1（右）が物理出⼒ 1（左）、再⽣チャンネル 2 が物理出⼒ 2 に割り当てられています
（以下同様）。 

再⽣チャンネル番号の隣りにある“+”および“-”ボタンを押すことで、再⽣チャンネルと物理出⼒の
割り当てを変更することができます。ダイアログ下部の“STEREO LINK”ボタンを有効にすると、
チャンネル割り当てがペアごとに変更されます。ステレオ信号を扱う場合に便利な機能です。 

DirectWIRE 出⼒チャンネルの設定例 

チャンネル割り当ての設定例を紹介しましょう。 
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上図の例では、再⽣チャンネル 5/6 が物理出⼒ 1 および 2 に、再⽣チャンネル 1/2 が物理出⼒ 3 お
よび 4 に、再⽣チャンネル 3/4 が物理出⼒ 5 および 6 に、再⽣チャンネル 7/8 が物理出⼒ 7 および
8 に割り当てられています。これらは、STEREO LINK を有効にして設定されています。 

以下は別の⾯⽩い設定例です。 

 

この設定では、すべての物理出⼒チャンネルペアが、再⽣チャンネル 1/2 の信号を出⼒します。
オーディオアプリケーションからのステレオ再⽣チャンネルを、すべての物理出⼒に“クローン”す
る場合のセットアップです。 

DirectWIRE 設定の変更は、オーディオ再⽣中であっても即座に反映されることにご注意くださ
い。設定をリセットするには、ダイアログを右クリックし、“Reset routing to default” を選択しま
す。 
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3.3 Windowsオーディオ設定 

Windows の“サウンド”コントロールパネルアイコンまたは ESI コントロールパネルのメニュー
“File” > “Windows Audio Settings ” を選択すると、“再⽣”および“録⾳”タブを含む“サウンド”ダ
イアログが表⽰されます。 

   

“再⽣”タブには、ステレオペアーごとに 4 つのデバイス（GIGAPORT eX CH1&2、GIGAPORT eX 
CH3&4、GIGAPORT eX CH5&6、GIGAPORT eX CH7&8）が表⽰されています。これらのいわゆ
る MME/WDM デバイスは、それぞれチャンネルペアの再⽣デバイスとして表⽰され、デフォルト
では同じ番号の物理出⼒が割り当てられています。このようにデバイスが出⼒ごとに分かれている
と、複数アプリケーションから各物理出⼒に同時にアクセスしたり、⽤途に応じて出⼒デバイスを
選択したい場⾯などに⾮常に便利です。 

“再⽣”タブには、GIGAPORT eX からの“スピーカー”デバイスも表⽰されています。通常は規定の
デバイスとして選択されているこのデバイスは、最⼤ 8 チャンネルまでの任意のチャンネルを使⽤
できます。オーディオアプリケーションによっては、“構成” > “スピーカーの設定” にて、使⽤する
出⼒チャンネル数を指定する必要があります。“ステレオ” （= 2 出⼒チャンネル）、“4 チャンネ
ル” （= 4 出⼒チャンネル）、“5.1 サラウンド”（= 6 出⼒チャンネル）、“6.1 サラウンド”（= 7
出⼒チャンネル）、“7.1 サラウンド” （= 8 出⼒チャンネル）。再⽣に同時使⽤するチャンネル数
をこの中から選択します（“7.1 サラウンド”を推奨）。 

コンピューターにインストール済みの別のオーディオハードウェアも Windows の“サウンド” コン
トロールパネルにデバイスとして表⽰されます。規定のデバイス（Windows システムやウェブブラ
ウザーの再⽣⾳など）としてどのハードウェアを使⽤するかをここで選択できます。規定のデバイ
スを設定するには、“サウンド” コントロールパネルで⽬的のデバイスを選択し、“規定値に設定” ボ
タンをクリックします。 
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多くの（特にプロ⽤）オーディオアプリケーションは独⾃の設定画⾯を備え、使⽤デバイスとASIO
ドライバーをアプリケーションごとに選択できます。これによりシステムのサウンド設定を無視
し、アプリケーションからハードウェアに直接アクセスすることが可能になります。 

3.4 DirectWIREループバック 

GIGAPORT eX は、DirectWIRE ループバックという機能を備えます。再⽣信号を内部的に録⾳で
きる機能です。たとえば、あるアプリケーションのオーディオ再⽣信号を別のソフトウェアで録⾳
したり、DJ ミックスのマスター出⼒を同じコンピューターで録⾳することが可能です。また、オン
ライン配信と同時に録⾳したり、ソフトシンセアプリケーションの出⼒を録⾳することもできま
す。内部的には、システム内で再⽣信号がデジタル的に 1 対 1 で同⼀伝送されます。 

Windows “サウンド” コントロールパネルおよびオーディオアプリケーションのオーディオ設定に
て、“GIGAPORT eX Loopback ”という名の 2 チャンネル MME/WDM⼊⼒デバイスが確認できます
（前章の画像参照）。ASIO 互換アプリケーション内では、この 2 系統の⼊⼒チャンネルを選択で
きます。物理出⼒チャンネル 1 および 2 から再⽣されるあらゆる信号を、同じまたは別のアプリ
ケーションで内部的に録⾳できます。 

この機能を⽤いて録⾳できるのは、物理チャンネル 1/2 から出⼒される信号だけです。再⽣チャン
ネル 3〜8 の再⽣信号を録⾳することはできません。ただし、DirectWIRE 機能を⽤いて再⽣チャン
ネル 3〜8 を物理出⼒チャンネル 1/2 に割り当てた場合は、それらの信号の録⾳も可能です。 
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4. OS X / macOS コントロールパネル 

本章では、Mac版 GIGAPORT eX コントロールパネルについて解説します。OS X / macOS では、
GIGAPORT eX アイコンが “アプリケーション” フォルダーにインストールされます。このアイコン
をダブルクリックすると、コントロールパネルソフトウェアが起動し、以下のダイアログが表⽰さ
れます。 

 

“File” メニューの “Always on Top” オプションを有効にすると、他のソフトウェア使⽤中もコント
ロールパネルウインドウが常に前⾯に表⽰され、このダイアログから macOS のオーディオ設定に
簡単にアクセスできます。“Config” メニューの “Factory Defaults” を選択すると、コントロールパ
ネルとドライバーのパラメーターが初期値にリセットされます。また、“Help” > “About” にて、現
在のバージョン情報を確認できます。コントロールパネルの “OUTPUTS” 下部には、以下のセク
ションが表⽰されます。 

1 / 2、3 / 4、5 / 6、7 / 8 

すべての再⽣チャンネルのボリュームコントロールスライダーがステレオペアーで表⽰されます。
各スライダーの下側には、ミュートボタン（“M”）を備えます。LR チャンネルを同時にステレオ仕
様でコントロールするには、スライダー下部の “LINK” スイッチをオンにする必要があります。オ
フにすると、各チャンネルを個別にコントロールできます。 

MASTER 

すべての再⽣チャンネルをミックスした信号のボリュームコントロールスライダーが表⽰されま
す。各スライダーの下側には、ミュートボタン（“M”）を備えます。LR チャンネルを同時にステレ
オ仕様でコントロールするには、スライダー下部の “LINK” スイッチをオンにする必要がありま
す。オフにすると、各チャンネルを個別にコントロールできます。 
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Sample rate 

ウインドウ最下部には、現在のサンプルレートが表⽰されます。サンプルレートの値は、メニュー 
“Config” > “Samplerate” から変更できます（再⽣中は変更不可）。GIGAPORT eX はデジタル
オーディオインターフェイスです。すべてのアプリケーションおよびオーディオデータは、同じ
サンプルレートで⼀様に処理されます。ハードウェアは、44.1 kHz〜192 kHz にネイティブ対応し
ています。 

4.1 レイテンシーおよびバッファー設定 

Windows と異なり、OS X / macOS のレイテンシーは、使⽤するオーディオアプリケーション
（DAW など）に依存します。多くの場合、コントロールパネルではなくアプリケーション内のオー
ディオ設定画⾯で設定します。詳細は、お使いのオーディオアプリケーションのマニュアルをご参
照ください。 

4.2 OS X / macOS オーディオ設定 

OS 付属の� Audio MIDI 設定（“アプリケーション” > “ユーティリティ”、または ESI コントロール
パネルからアクセス）にて、GIGAPORT eX が 2 イン 8 アウトのデバイスとして表⽰されます。 

“オーディオ機器” の “出⼒” タブは以下の通り表⽰されます。 

 

8 つの出⼒チャンネルすべてが表⽰され、各チャンネルのボリュームを調整できます。“フォーマッ
ト” にて、デフォルトの解像度とサンプルレートを変更できます。 
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“⼊⼒” タブは以下の通りです。 

 

DirectWIRE のループバック録⾳（次章で解説）に使⽤される 2 つの⼊⼒チャンネルが表⽰されま
す。“フォーマット” にて、デフォルトの解像度とサンプルレートを変更できます。 

4.3 DirectWIRE Loopback 

GIGAPORT eX は、DirectWIRE ループバックという機能を備えます。再⽣信号を内部的に録⾳で
きる機能です。たとえば、あるアプリケーションのオーディオ再⽣信号を、別のアプリケーション
で録⾳したり、DJ ミックスのマスター出⼒を同じコンピューターで録⾳することができます。ま
た、オンライン配信と同時に録⾳したり、ソフトシンセアプリケーションの出⼒を録⾳することも
できます。内部的には、システム内で再⽣信号がデジタル的に 1 対 1 で同⼀伝送されます。 

2 チャンネルの⼊⼒デバイスは、オーディオアプリケーション内の録⾳に使⽤できます（ほとんど
のアプリケーションで“GIGAPORT eX”と表⽰されますが、内部的には“ループバック 1”、“ループ
バック 2”と名付けられています）。物理出⼒チャンネル 1 および 2 から再⽣されるあらゆる信号
を、同じまたは別のアプリケーションで内部的に録⾳できます。 

出⼒チャンネル 3〜8 からの信号は内部的に録⾳できません。再⽣チャンネル 1 および 2 の信号の
みを録⾳可能です。 
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5. 仕様 

製品概要 / 主な機能 

- USB 3.1 オーディオインターフェース（USB-C 端⼦・Type-C ケーブル付属） 

- USB 2.0互換（USB Type-A to C ケーブル付属） 

- USB バスパワー駆動 

- DirectWIRE 出⼒チャンネル・ルーティング対応（Windows） 

- DirectWIRE ループバック機能（Mac/Windows） 

オーディオ仕様 

- 8 チャンネルアナログ出⼒（-10dBV RCA 端⼦） 

- 2 系統ヘッドホン出⼒ 

・ 全再⽣チャンネル・ミックス⽤ 

・ チャンネル 1/2 ⽤ 

・ 1/4"ステレオ標準端⼦ 

・ 最⼤出⼒レベル︓+6.4dBu (@ 0dBFS) 

・ THD+N︓0.0024% A-weighted (@ fs=48kHz) 

・ インピーダンス︓32~600Ω 

- DA コンバーター︓24bit/192kHz（全チャンネル出⼒対応） 

・ ダイナミックレンジ︓114dB (A-weighted) 

・ THD+N︓-100dB (@ 0dBFS) 

互換性 

- Windows 7〜10 / ASIO 2.0、MME、WDM、DirectSound 

- macOS 10.9以上 / CoreAudio 対応ドライバー不要 
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6. ⼀般情報 

商標 

ESI、Gigaport eX は、ESI Audiotechnik GmbH の商標です。Windows は、Microsoft Corporation
の商標です。その他の製品名及びブランド名は、それぞれの会社の商標または登録商標です。 

免責事項 

すべての機能と仕様は予告なく変更される場合があります。また、このマニュアルの⼀部は継続的
に更新されています。最新の更新情報については、ESI または国内総代理店（株）銀座⼗字屋ディ
リゲント事業部の Web サイトにてご確認ください。 

お問い合わせ窓⼝ 

本書をご覧いただいても解決できない問題がございましたら、ディリゲントのカスタマー サポート
までご連絡ください。 

なお、サポートサービスをご利⽤いただくためには、ディリゲントへのユーザー登録が必要です。
登録の確認ができない場合、サポートサービスをご利⽤いただくことができません。予めご了承く
ださい。 

ディリゲントへのご登録⽅法︓ディリゲントサポートページにアクセスし、ESI オンライン登録
フォームよりご登録をお願いいたします。 

● ディリゲントサポートサイト︓https://dirigent.jp/support/ 

ご登録の完了後、ディリゲントサポートページにログインするとお問い合わせフォームをご利⽤い
ただけます。 
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